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Hardware Requirement and Software Installation

Hardware Requirement

- S32G-VNP-RDB2
- S32 Debug Probe
- AD/DC power supply

- Serial port cable for UART example

Software Installation
- S32DS3.4 according to S32G-VNP-GLDBOX Software Enablement Guide
- SW32 RTD 4.4 1.0.0(RTD) according to S32G-VNP-GLDBOX Software Enablement Guide
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Hands on UART Example
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Hands on UART: Objective

- How to import the UART example into S32DS

— How to configure the clock of UART via S32DS

— How to configure the UART setting via S32DS

— How to debug the UART example with S32 debug probe
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Hands on UART: Import UART example project

Open S32DS3.4, go to “File -> New -> S32DS Project From Example”. Select “Uart. HLD S32G_DS Example” example,
Then click on “Finish”. The project should now be copied into current workspace.

workspaceS32D5.3.4 - Linflexd_Uart_Ip_S32G_DS/src/mair
) wzos.s..: - Linflexd_Uart_Ip_S32G_DS/description.txt - $32 Design Studio for $32 Plat 53205 Project from Example. o x File Edit Source Refactor Navigate Search Project Con
: S ; ™ =
1 ce Refactor Nav arch _Projec figTools R indow Hel BrEGle xSy &ic=e @&y
1| Wgurce Refactor Navigate Search Project ConfigTools Run Window Help Create 532DS Project from Example : ST e
I <3205 Proies from E " ] & Project Explorer &2 =UE
Open File.. 53205 Library Project & Ocotp AUTOSAR_Example: Debug RAM ~
S32DS Application Project :  Ne A
i Open Projects from File System. pplicati e Project name: art_HLD_532G.DS. Example = Pit_example_DS: Debug_RAM
Recent Files » ¥ Makefile Project with Existing Code [E——— ] ower_Ip_Example_CT: Debug RAM
C ++ Py - De A
Close culew ot Proma Examples: Description DB2_LED_1_M7_0: Debug_RAWM
Close All Ctrl+Shifte W i & Tmu_ip_example ~ | 1. Example Description ~ Spi |P e@'nole C] S32G: Debug RAM
; = Convert to a C/C+ + Project (Adds (I v 5§32 RTD AUTOSAR 4.4 D2012 Uart Fxam This is a simple application which shows the ~ & Uart HLD_S32G_DS_Example: Debug_RAM
Source Folder & Linflexd_Uart_Ip_$32G_DS usage of Uart driver L
Folder [© Uart_HLD 5326, D5 _Example | - T'?‘“'P:"I"T"_:‘D" software functionalty = Proi ]
2 Source b « 532 RID AUTOSAR 4.4 D2012 Wdg Exarr rLini Project Settings
urce Fie ) Initialize the pins used by the & b d
* Header File « Wdg_Example HLD DS application using the Port driver. oar
File from Template J ngiE:almpleilFLDS - Mcu_Init) & generate
C s v & User bamples Maw InitClock) 8 generate/IntCtrl_|
™ Rename R |* Class & MOplus S Mecu_DistributePIClock() g / -P
Refresh F5 ™ Example ‘ N Meu_SetMode() . & generate/System_Ip
Convert Line Defimiters To > ™ Other o ’ & generate/indude
& generate/src
2 src
£ ancel
2 RTD

2 description.txt
# Uart_HLD_S32G_DS_Example.mex

The purpose of “Uart HLD S32G DS Example” example is a simple application which shows the usage of
UART driver. N “Hello”

>
“Hello World” S32G-VNP-RDB2
/ \ S32 Debug Probe J48 JTAG

A
| Serial port cable UART1
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Hands on UART: Clock Configuration 1

. . . [ workspaces320s.3.4 - Uart HI r 532 Platform
Go to desired configuration tool: Fle £t Source Refacor Nawi  New >
AR ®~& v @i Go Into P v Bin| &I v
- Right click on Project, s Project Bplorer = Open n New Window
=% Ocotp_AUTOSAR_Example Show In Alt+Shift+w >
. . & Pit_example_DS: Debug RAI i i
- Select S32 Configuration Tool 5 Power p Example CT: by 1o Lo Tl " [FoStatusType Uart status;
e owWer_IpDample PR copy CtleC LReturnType Std_Uart_Status;
= RDB2_LED_1_M7_0: Debug_ X Delete Delete mainingBytes;
LS lP avampls O G205 0 fer[MSG_LEN];
- Select Open Clocks o Paste Cuv -
I v B Uar‘tﬁHLDfSS2GfDSfExamp|n| i
— @ Rename... F2  us = E NOT OK;
o neudes Source > le the Mcu driver */
2 Project_Settings irie LL_PTR);
& RTD ze the clock tree and apply PL
& board &1 Import... ck(McuClockSettingConfig_e);
& generate & Export. | PLL_LOCKED != Mcu_GetP1llStatu
& generate/IntCtrl_Ip Build Project wait until the System PLL is
& generate/System_Ip Clean Project
& generate/include # Refresh
& generate/src ) ite the PLL across the clock tr
v 8 src Close Project utePllClock();
Close Unrelated Projects
£ main.c
2 include Build Targets >
B description.txt Index > mode configuration */
& Uart HLD 532G DS Exan Build Configurations > |(McuModeSettingConf_e);
< Build path 3 b 211 mime neine dha daamessdiu
£ Dashboard # Build Configurations Explorer = =i
- - a0 U1 Open Clocks I
~ Project Creation s ¥ Open Peripherals

(¥ $32DS Application Project Migrate... # QOpen DCD

& 53205 Library Project _ Show in Remote Systems view = Open VT

~ Build/Debug " © RunAs > Open QuadSP

& Build (Al # Debug As > # OpenDDR

# Clean (All) i Import Configuration (*.mex)
% Debug I 532 Configuration Tools I > Manage SDK Components

Team > [
A01AM f 2NN2M T B> Lart
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Hands on UART: Clock Configuration 2

Open the Peripheral Clock View, Double click the Lin module. The Clocks Diagram will show the power tree .In
Uart HLD S32G_DS_ Example project. The default clock configuration of UART is 48 MHZ which comes from FIRC directly

A Ov.. Pe.. ®

Co... (IRe.. EDe.. OCl...

= O

Clock Name Enable Source Divider Freq ™
IC3_CLK M XBA.. /1 133.
I1C4_CLK M XBA.. /1 133.
LBISTO_CLK M COR.. /16 50 N
LBIST1_CLK M COR.. /16 50 N
LBIST2_CLK M COR.. /16 50 N
LBIST3_CLK M COR.. /16 50 N
LBIST4_CLK M COR.. /16 50 N
LBIST5_CLK M COR.. /16 50 N
LBIST6_CLK M COR.. /16 50 N
LBIST7_CLK M COR.. /16 50 N
LINO_CLK i FIRC... /1 48 N
LINT_CLK M FIRC.. /1 48 N
LINZ2_CLK M FIRC.. /1 48 N
OCOTPO_CLK M FIRC.. /1 48 N
PFEMACO RX_CLK [ FIRC.. /1 48 N
PFEMACO_TX_CLK M FIRC.. /1 48 N
PFEMACT RX_CLK 1 FIRC.. /1 48 N
PFEMACT TX CLK M FIRC.. /1 48 N v

v

Fig. Peripheral Clock View

EXTERNAL USE

FIDSC CLE Mz
g B
FTE 0 E¥T REF X miz
. ) FIY L BT K fﬁ‘
FIRC 4 |500 Mz { ORAC EXT T3, REF 4%3 i
32 kHz e p— CORE_PLL DFS1 GAAL EXT % % ] E{*
i e FFEMACT EXT REF 4 iz
....................... MORE FLL TRSD sl 7 L PEENA] EXT REF l*j Wiz
PERIPHPLL_PHI3
FXOSC_CLK 1
FIRC_CLK
NPT FTE
Fig. Clocks Diagram
\
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Hands on UART. UART Configuration 1

Open the Clocks Diagram:
- Right click on Project,
- Select S32 Configuration Tool...
- Select Peripherals

8 EXTERNAL USE

workspaceS32DS.3.4 - Us

File Edit Source Refactor

&5 Project Explorer &

Hwih A= =N LN

Pit_example_DS: Debu;

53

=% Power_|p_Example_CT
== RDB2_LED_1_MT7_0: De
=5

Spi IP example CT 53:
|v 5% Uart HLD S32G_DS_Ex _l

& Includes

& Project_Settings

&= RTD
£ board
& generate

2 generate/IntCtrl_Ip

= generate/System_Ig

# generate/include

& generate/src
v B src
& main.c
2 include
2 description.txt

B Uart_HLD_S32G_DS

<
#3 Dashboard %

- Project Creation

[27 S32DS Application Proje
= S32DS Library Project

~ Build/Debug
& Build (All)
# Clean (All)
% Debug

ANCALA L YNOORA

L

E

E

New

Go Into

Open in New Window
Show In
Show in Local Terminal

Copy
Delete

Paste

I Rename...

Source

Move...

Import...

Export...

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Projects
Build Targets

Index

Build Configurations
Build path

Build Configurations Explorer
SDKs

Migrate...

Show in Remote Systems view

© Run As
4 Debug As
Restore from Local History...
I ‘® S32 Configuration Tools I
Team

=

Alt+Shift+

W >
>

Ctrl+C
Delete
Ctrl+V
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io for $32 Platform

Help
vi®™ . v H=ERNIPCRE 2

asm routine

d)

Uart_StatusType Uart_Status;
Std_ReturnType Std_Uart_Statu:
arRemainingBytes;
. Buffer[MSG_LEN];

| Status = E_NOT_OK;

Blize the Mcu driver */

t (NULL_PTR);

ialize the clock tree and apply
tClock(McuClockSettingConfig_ e’
MCU_PLL_LOCKED != Mcu_GetP11S4

Busy wait until the System PLL

ribute the PLL across the clocl
tributePl1lClock();

P~ ommdAn ,reanEs et A K

™ Open Pins

n Clock:
I ¥ Open Peripherals I

# Qpen DCD

Open IVT

Open QuadSPI

Open DDR

Import Configuration (*.mex)

(C]

T Hhm

Manage SDK Components

8



Hands on UART:. UART Configuration 2

The Components shows all drivers which used by this example, the UART 43 LINFLEXD 1 includes
the configuration of UART driver

& Components ¥ | ¥ Peripherals ' 7 Start [%Siul2 Port 1 [% Uart 43 LINFLEXD 1 % -
[|& 1 Uart Configuration pcay;
Name Uart_43_LINFLEXD_1 Custom namr
MCAL L+ i -
Mode AUTOSAR Mode
“'Dem_1 “Mcu_1 “Platform_1
ConfigTimeSupport | GeneralConfiguration | UartEcucPartitionRef | UartGlobalConfig| CommonPublishedIinformation
=
3 Uart_43_LINFLEXD_1 ‘ G
~ 0
Drivers +]
Uart Channel ID 0
x . [
osif_1 Siul2_Port_1 UartHwChan LinflexD_1 v
os o Clock Reference | /Mcu_1/Mcu/McuModuleConfiguration/McuClockSettingConfig_0/McuClockReferent v

~ DetailModuleConfiguration

Desire Baudrate UART_BAUDRATE_9600 v

UART default configuration:
- - Select correct COM Port
- Select Baudrate of 9600

onous Method LINFLEXD_UART_IP_USING_INTERRUPTS v

Uart Parity Enable ]

- INFLEXD_UART_IP_PARITY_ZERO
) ) LINFLEXD_UART IP_ONE STOP BIT v
- - Select none parity CheCklng Uart Word Lengt LINFLEXD_UART IP_8 BITS v
- - Select 1 StOp bits UartCallbackRx INULL_PTR |
. UartCallbackTx INULL_PTR |
- - Select 8 data bits ; | o,
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Hands on UART:. Update code

B o oCTIME T A L Ebl Eves mle TIE I S I PR EO S L 1o I 1 | I T-JE) ¥ (UTEN , SN Lo
Bl workspacesscllsos - cin_cxample Us W/ SrGmain.c - o Uesign sTudio Tor 2a2 Fla
File Edit Source Refactor Mavigate Search Project ConfigTools Peripherals Run Window Hel;
Generate code method: = » [ | @ "Uart HLD 532G_DS_Examplet @ﬁ A B Update Code ~| ® Functional Group VS 0
1.Click on any configuration tool, like Pins & Components % Siul2_Port_1 (% Uart 43_LINFLEXD_1 % Platform 1 :
Then click Update Code (ensure desired
prOJeCt IS SeIeCted!) v &% Uart_HLD_S32G_DS_Example1
2.The Update Flle_s wmdoyv pops up. It shows Update Files O x [
the detail update information. Click ok button. o).
. . - - fil y | 2 generate
3.The configuration .c and .h file will be el s @I 7 s
generated at “generate” folder. -8 board\ ol gt O
BSiul2_Port_lp_Cfg.c 4 no change gezeyzf:y‘;‘i':‘g':
= SiU'Z_pDFth_':fg.h * Mo Change geneta(e/i;\d;de
“EClocks ‘gf rl?r:‘::;:j}arup_VS_O‘PBdg.c
-E boardlll' i xi:tsfs(g_;_PBcfg.c
B Clock_|p_Cfg.c “ no change E Oslf{Cfg»c(
B Clock_Ip_Cfg.h 4 no change ::;Z::]Cpifag.c
B Clock |p_ Cfg_Defines.h # no change : ::Zt:zf/s;img_(
B Clock_|p_PBcfg.c 4 no change W : f;amf:Pfsfsg»; -
2 Uar o, 5.0, PRl
4 Uart_VS_0_PBcfg.c
Options pé ;:bug_RAM
Always show details before Update | [ OK Cancel ' :
“
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Hands on UART:

Open the main.c file in S32DS

Application code 1

int

main(void)

volatile Uart_StatusType Uart_Status;
volatile Std_ReturnType Std_Uart_Status;
uint32 varRemainingBytes;

uint8 Rx_Buffer[MSG_LEN];

Std_Uart_Status = E_NOT_OK;
/* Initialize the Mcu driver *

Mcu_Init(NULL_PTR); MCU cIock |n|t|at|on

* Initialize the clock tree and apply PLL as system clock *

Mcu_InitClock(McuClockSettingConfig ©);
while ( MCU_PLL_LOCKED != Mcu_GetPllStatus() )
{

}

* Busy wait until the System PLL is locked *

/* Distribute the PLL across the clock tree */
Mcu_DistributePllClock();

/* Apply a mode configuration *
Mcu_SetMode (McuModeSettingConf_8);

Uart_Setup_Pins();

* Initialize all pin

the transceiver */

11

initializZe IRQs *

Platform_Init(NULL_PTR);
Platform_InstallIrqHandler(LINFLEXD1_IRQn, LINFLEXD1_UART_IRQHandler, NULL_PTR);

EXTERNAL USE
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/* Init Pins */
void Uart_Setup_Pins(void)

{
/* LINFLEXD1_TX: PA_13 */
t_reg_write(e@x4009C274, ©x00200002);
/* LINFLEXD1_RX: PB_e@e */
t_reg_write(©x4009C288, ©x000880000);
t_reg_write(©x44e10DCB, ©xe2);

}

In Uart HLD_S32G_DS_Example Project.

Initialization of pins is writing register directly.

PUBLIC 11




Hands on UART: Application code 2

while (1)
{

/* Receive and store data byte by byte until new line character is received,
* or the buffer becomes full

(void)Uart_AsyncReceive(UART_CHANNEL, Rx_Buffer, strlen{EXPECT_RX_MSG));
I » ii.: '—EE :Eiﬂiiiﬁ £ hi GGEDJG’E"‘ 9 J

while(Uart_GetStatus(UART_CHANNEL, &varRemainingBytes, UART_RECEIVE) == UART_OPERATION_ONGOING);

'* Check the status */
Uart_Status = Uart_GetStatus(UART_CHANNEL, &varRemainingBytes, UART_RECEIVE);

if (Vart_Status != UART_NO_ERROR)

{
/* If an error occurred, send the error message and exit the loop */
(void)Uart_AsyncSend(UART_CHANNEL, (const uint8 *)ERROR_MSG, strlen(ERROR_MSG));
while(Uart_GetStatus(UART_CHANNEL, &varRemainingBytes, UART_SEND) == UART_OPERATION_ONGOING);
break;

}

/* Send the received data back
Std_Uart_Status = Uart_AsyncSend(UART_CHANNEL, (const uint8 *)SEND_MSG, strlen(SEND_MSG));
while(Uart_GetStatus(UART_CHANNEL, &varRemainingBytes, UART_SEND) == UART_OPERATION_ONGOING);
break;

12 EXTERNAL USE

Receive data from user

Echo the received data back
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Hands on UART: Build and Debug 1

Build the target :

Right click on Project,
Select Build Project

v & Linflexd_Uart_Ip_S32G_DS: Dehuin RAM

& Binaries
» Includes
& Project_Settings
& RTD
» @ board
& generate
& generate/include
8 generate/src
& src
@ Debug_RAM

LB ' ' S
& Md_IP_Example_CT: D¢
% Ocu_example_DS
% Ocu_Ftm_example_DS
& Port_example_DS: D
5 Pwm_Example_DS

€ Ndaa cicaecle NN

13 EXTERNAL USE

New

Go Into

Open in New Window
Show In
Show in Local Terminal

Copy

X Delete

T Paste

™ Rename...
Source

Move

= Import...

F & Export..

|

Clean Project
Refresh
Close Project

Alt+Shift+W

Ctrl+C
Delete
Ctrl+V

F2

Print Build information on Console window
Uart HLD S32G_DS Examplel.elf is generated

>

>

—)

¥ & Uart_HLD_S32G_DS_Example: Debug RAM

v & Binaries
| # Uart HLD 532G_DS_Example.elf - [arm/le] |
J Includes
@ Project_Settings
& RTD
& board
& generate

& generate/IntCtrl_Ip
& generate/System_Ip
@ generate/finclude

&= generate/src

& sre

= Debug_RAM

¥ i

H de

= HLD 532G DS Example.mex

I Problems ¥ Tasks @ Console [ Properties + Search = Progress

COT Build Console [Uart_ HLD_S32G_DS_Example1]
Building target: Uart_HLD_S32G_DS_Examplel.elf
Invoking: Standard S32DS C Linker
arm-none-eabi-gcc -o "Uart_HLD_S32G_DS_Examplel.elf" "@Uart_HLD_S32G_DS_Examplel.args"
Finished building target: Uart_HLD_S32G_DS_Examplel.elf
|

|
Invoking: Standard S32DS Print Size
arm-none-eabi-size --format=berkeley Uart_HLD_S32G_DS_Examplel.elf
text data bss dec hex filename
309808 %) 12288 322096 4ea30 Uart_HLD_S32G_DS_Examplel.elf
Finished building: Uart_HLD_S32G_DS_Examplel.siz

10:04:55 Build Finished. © errors, © warnings. (took 6s.982ms)
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Hands on UART:

Go to debug configuration:
- Right click on Project,
- Select the Debug As
- Click Configurations

E Uart HLD S32G * El'e'e Delete
te Ctrl+V

sea uEnE @vang
Before runnir
Compiling the

wioBow e
w
~N

NN R

™ Rename... F2 Select the cc
Source > Use Project
M Wait for the
should be crg
= Import... Running the 4
< Export Go to Run and
Build Project
CleanProject | 27 N
Refresh Fs $(example) D4
Close Project Select the de
Close Unrelated Projects 37 Use the contr
Build Targets >
Index >
Build Configurations >
|
1 Dashboard Build path > <
z = Build Configurations Explorer
* Project Creation o B Console
S
S32DS Applicatic A COT Build Console [Uart HLD_S32
¥ S32DS Library Pri e Building target:
- Build/Debug Show in Remote Systems view Invoking: Standard S32DS
% Dic A sl arm-none-eabi-gcc -0 "Ua
Build (All) -t e aa taas & t
¢ Clean (AlD [ 4 Debug As I > [ 1 Local C/C++ Application
t Debug Restore from Local History... @ 2 S32DS C/C++ Application s
. Settings ® S32 Configuration Tools > [_ Debug Configurations... Ir

14 EXTERNAL USE

Build and Debug 2

Debug configuration set:
- Click target project ,
- Select the target device

- Select target S32 Debug Probe

¥ & x b
type filter text
[ C/C++ Application
[E] C/C++ Remote Application
@ Edlipse Application
=1 GDB Hardware Debugging
K& GDB PEMicro Interface Debugging
[£] GDB SEGGER. J-Link Debugging
@ Launch Group
¥ Launch Group (Deprecated)
¥ Launch Group for 532 Debugger
v = 532 Debugger
CAN_example_CT_Debug_RAM_532Debug
Eth_Example_DS_001_Debug_RAM_532Debug
= FlexCAN_example_CT_Debug_RAM_S32Debug

| _HLD_ U5 Uebug eoug
Wdg_Example_IPL_DS_Debug_RAM_S32Debug
v = 532 Debugger Flash Programmer
= New_configuration

VLAB Simulator Debugging

| Mame: | Uart HLD_S326_DS_Example_Debug_RAM_S32Debug

2l Main | %% Debugger ., * Startup % Source| D Common i SVD Support # OS Awareness

Hardware

[pevice: 326274 Reva  Care: M7 0 | Select device and core

Initialization script: .${532 DS_INITIALIZATION_SCRIPTS_DIR)/s32g2:xx/s32g2xx_generic_barel
Initial core

Debug Probe Connection

Interface: 532 Debug Probe - USB »

USB device:  ||00:04:9£.06:20:40 - 532 Debug Probe ~|

Hostname or IP:

Target Communication Speed

JTAG Speed (KHz): |16000|  Timeout:|30  |s
[ Delay after reset: 0 ms

GDB Server

Launch server

Server port numbetﬂ'_dSO[}_
[ ]Enable log

GNR Cliont
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Hands on UART : Debug and run

15

Click on “Apply”, then click on “Debug”. the perspective will jump to the Debug Perspective, and you can
use the controls to control the program flow.

Debug Probe Connection workspaceS32DS.3.4 - Uart_HLD_S32G_DS_Examplel/Project_Settings/Startup_Code/stal
Interface: 532 Debug Probe - USB v 5 - - - -
USE device L LR LTALAT S22 Ty rete i File Edit Navigate Search Project ConfigTools Run FreeRTOS Window Help
- - I T P ey BvOvQ v
Hostname or IP:
- - | 3 =
Target Communication Speed s Debug Lol e PYOJCCt Explorer 3
JTAG Speed (KHz): Timeout:[30 s v = Uart_ HLD_S32G_DS_Example1_Debug_RAM_S32Debug [S32 Debugger]
[ ] Delay after reset: 0 ms v & Uart_HLD_S32G_DS_Example.elf [1] [cores: 0]
GDB Server v & Thread #1 1 [core: 0] (Suspended : Signal : SIGINT:Interrupt)
Launch server = _end_of_eunit_test() at startup_cm7.5:477 0x34000146
Server port number|4500] = Uart_lpw_GetTransmitStatus() at Uart_Ipw.c:453 0x3400959a
[ ] Enable log = 0x0
GDB Client " Sy 2
1 C/NXP/S32DS.3.4/532DS/tools/gdb-arm/arm32-eabi/bin/arm-none-eabi-gdb-p
Executable: |$(S32DS_GDB_ARM32_PY) | select : -
Frarmeroem de. | v ! S32 Debugger
< z ! Semihosting

Revert ‘ Apply
[ Debug | close

EXTERNAL USE
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Hands on UART: Test result

« Connect the PC and UART1
* Open Tera Term and Set the serial port

* the terminal software will show the below
messages. input “Hello”, UART output “Hello
World”

532 Debug Probe
Ne

16 EXTERNAL USE

YT COM6 - Tera Term VT

File Edit Control Window Help

SSH Authenticition...
SSH Forwardind}..

SSH KeyGeneratdyr...
TCP/IP...
General...

Additional settings.

Tera Term: Serial port setup

Port: COM6

Data: 8 bit

Parity: none

Flow control: none

Transmit delay

0 msecfchar

Speed: 9600

0

msecfline

¥ COMG - Tera Term VT

Control

PUBLIC 16
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04.

Hands on ETH Example
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Hands on ETH — Objective

—How to import the ETH example into S32DS

—How to configure the clock of ETH via S32DS

—How to configure the port of ETH via S32DS

—How to use the ETH module to transmit/receive ETH frame
—How to debug the ETH example with S32 debug probe

18 EXTERNAL USE
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Hands on ETH: Import ETH example project

Open S32 Design Studio, go to “File -> New -> S32DS Project From Example”. Select “Eth _Example DS 001" example,

then click on “Finish”. The project is copied into current workspace. :
= CAN_example CT1
& Clock_Ip_Example CT

I+ &5 Eth_Example_DS_001: De

- PR T
BB 53205 Project from Example, [} X P TTTTUIEE'S

w workspace532D5.3.4 - Linflexd_Uart_lp_532G_D5/description.txt - 532 Design Studio for 532 Plat
File Edit Source Refactor Mavigate Search Project ConfigTools Run Window Help
New Alt+Shift+N > = 532DS Project from Example

Create 532DS Project from Example

& Project_Settings
Open File... = S532DS Library Project

: . * 53205 Application Project i & RTD
s Open Projects from File System... Pp! ) Project name: | Eth_Example DS_001
Recent Files > EI Makefile Project with Existing Code or sparch tev = |:| Wl d
& C/C++ Project Examples: Description:
Close Culsw Project... ! & Hse_Ip_Aes._Enc_Async_lrq | [1. Example Description ~ ‘ & generate
Close All Ctrl+Shift+ W & Hse_Ip_Read_Hse_Attr This application demonstrates the progress .
= Convert to a C/C++ Project (Adds C + & $32 RTD AUTOSAR 4.4 D2012 Dio Examg| | Uransmit and receive in internal loopback mode ) geng[ateﬂ nclude
Save Crl+s | Source Folder & Dio_example_DS._S32G 1.1 The application software functionality

- Osif_Init
Eolder “ & 532 RTD AUTOSAR 4.4 D2012 Eep Examy itislve timeout & generate/src
- Siul

save All Ctrl+Shift+S & Example 532G2XX_DS_Fep

i Siul2_Port_Ip_Init

o ¢ Source File « €532 RTD AUTOSAR 4.4 D2012 Eth Examp: ins used by the v 9 sre

e v Header File G Eth_Example DS 001 application  Port APL.

Move, File from Template & Eth_Example_DS 002 . -Clo v

Move.. Initialize the clock sources, the doc o= main.c
™ Rename... F2 | © Class Mareinlv ul il
“1 Refresh F5 O Example..

Convert Line Delimiters To > 4 Other... # d

Cancel el

This “Gmac_Example_DS 001" example demonstrates the GMAC transmit and receive in internal loopback mode. The
ETH frame is transmitted back directly through GMAC, and the frame will not be transmitted to PHY.

S32G

GMACO ETH|Frame KSZ9031

19 EXTERNAL USE
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&5 Clock Ip Example CT: Debu AM ‘25 I
n . . ¥ New > B /* Payload = Frame - (Ds
an S O n O r O n I g u ra I O n > Indudes 6o into B *((uint32 *)(txBuffer.da
L] @ Project S B
2 RTD Open in New Window L /* Send the ETH frame */
» bioaid Show In Alts+ShiftsW > £ FxBuffer‘.length = 64U -
g ) ) B if (GMAC_STATUS_SUCCESS
. . . & generate Show in Local Terminal > h {
Go to desired configuration tool: cute b result = FALSE;
& generate; X Delete Delete E }
. . . v Bsrc T Paste Ctr+V [ . =
* Wait f e frame
- Right click on Project, 0 main< 71 ename.. ERE o et
Source > p status = Gmac_Ip_Get
. . # de Ao L } while (status == GMAC_
- Select S32 Configuration Tool... % b ,
@ Biiniple S0 Import... B /* Check the frame statu
. & FloCAN ool @ BPOL ; if ((GMAC_STATUS_SUCCESS
- Select Open Pins 5 FreeR10S £ Buld Projet t - —_—
& led M7 0: D Clean Project y }
1 H H 1 &5 Linflexd_Uari Refresh B i e -
Configure pins to provide the external clock to Tx, Rx signals gl L b/ it or che frame
& Mdl_IP_Exam Close Unrelated Projects i status = Gmac_Ip_Rea
& Mcu_Exampl Build Targets 5 g } while (status == GMAC_
R350 0 GMACO_TX_CLK P20 , ©Ocotp AU G 4 . i) we
P15 RGMI_A_TXC R347 PE_02/GMACO_TX_CLK/PFE_MAC1_TX_CLK & Pit_example. e : {7 Check the. frame statu
P15 RGMIL A TX CTL AR GWACT-TXOU 77| PE_03(GMACO_TX_EN/PFE_MAC1_TX_EN  Power Ip x_ Build Configurations 3 2f ((GMAC_STATUS_SUCCESS
P15 RGMIL_A_TXDO R34 0 GMACU_TXDT T22 PE_04.*:GMACU_TXDU."PFE_D.-‘]AC1_TXDO  RDB2_LED_1 Build path > ¥ result = FALSE;
P15 RGMIL_A_TXD1 ! PE_05/GMACO_TXD1/PFE_MAC1_TXD1 & Spi_IP_ex . L .
R 0 GNVACU_TXDZ 22 : Spi_IP_exam Build Configurations Explorer B }
P15 RGMII_A_TXD2 S5 0 CVACT TXO3 T21 | PE_O6/GMACO_TXD2/PFE_MAC1_TXD2 &5 Uart HLD S: B
P15 RGMIL_A_TXD3 AAN = PE_07/GMACO_TXD3/PFE_MAC1_TXD3 i S?Ks 2 Gmac_Ip_ProvideRxBuff(IN
GMACO RX_CLK R21 Migrate... E .
P15 RGMILA_RXC gggl’l) 8 \Jl:\r\\_.u_ _v ﬁl PE_08/GMACO_RX_CLK/PFE_MAC1_RX_CLK Show in Remote Systems view : Gaec. A Disaulacontrolle
P15 RGMILA_RX _CTL WU CVA T P19 | PE_09/GMACO_RXDV/PFE_MAC1_RXDV O RinAs > b Exit_Example(result);
P15 RGMII_A_RXDO m’i\/\/\o T XD P1g | PE_10/GMACO_RXDO/PFE_MAC1_RXDO # Debug As > b N ’
P15 RGMII_A_RXD1 L NAVS X B PE_11/GMACO_RXD1/PFE_MAC1_RXD1 3 E 3
) S R334 0 7 GMALU_RADZ NT8 —. - - - Restore from Local History.. 3 return 0;
P15 RGMII_A_RXD2 Q332"\N0 —7” GWACU RXD3 U771 | PE_12/GMACO_RXD2/PFE_MAC1_RXD2 - = [ e P
P15 RGMI_A_RXD % = PE_13/GMACO_RXD3/PFE_MAC1_RXD3 i 23 Confipiation Took | ® openpins
- - - - - Project Creatic seam il s
53205 Appli Compare With N ‘ Open Peripherals
= S320S Library Configure 2 _. Open P
. Source e open v
* Build/Debug ¥ Open QuadSPI

Routed Pj g Qv

# Route to Label Identifier Power group Direction Output Buffer Open Drain  Input Buffer Slew Rate Control Pullup Enal

P20¢ 0 txcko PED2 nfa VDD 10 GMACO (0V) Qutput Enabled Disabled Disabled SIULZ_0: FAST pad: T66MHz(1.8V), 150MHz(3.3V) - GPIO pad: 166MHz(1.8V), 50Mhz(3.3V) 7 SIUL2_1: 150MHz or lower Disabled

R2WGMAC 0 meclki PEDS n/a VDD 10 GMACO (OV)  Input Disabled Disabled Enabled SIUL2 0: FAST pad: Te6MHz(1.8V), 150MHz(3.3V) - GPIO pad: 166MHz(1.8V), 50Mhz{3.3V) / 5IUL2_1: 150MHz or lower Disabled
20  EXTERNAL USE wr
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Hands on ETH : Clock Configuration 1

Open the Peripheral Clock View, Double click the GMACO module. The Clocks Diagram shows the power tree of
GMAC module

#& Overview © Periphera... ¥ [€ Code Pre... ElRegisters = Details & Cloc

Clock Name Enable Source Divider Frequency Monitor

EIM3_CLK XBA.. S 6b.66... ...
EIM_CLK XBA.. /1 66.66.. ...
ERMO_CLK ¥BA.. /1 66.66.. ... FIRC % ]800 MHz [ —
FLEXCANO_CLK FIRC.. /1 48 MHz 32 kHz CORE_PLL DFS1 L4
FLEXCAMNT_CLK FIRC.. /1 48 MHz 45 Wiz FIRC_CLE
FLEXCAMZ _CLK FIRC.. /1 B8MHz ) T (ORE PIT DFS2 N ~
FLEXCAN3_CLK FIRC.. /1 48 MHz
FRAY0_CLK FIRC.. /1 48 MHz ‘ r
FTIMERD_CLK FIRC.. /1 48 MHz ‘SERDES_U_LP\EE_Q_H_..\
FTIMER1 CLK FIRC. /1 48 MHz gmac_ext_ref - ) )
GMACD_RXY_CLK FIRC.. /1 48 MHz gmac_ext_tx_ref > ﬂ‘?é‘%lﬂ};
GMACO TS CLE FIRC.. /1 48 MHz PERIPHPLL_PHI3 N
GMACD TX CLK FIRC.. /1 48 MHz FIRC CLK "
NCO_CLK XBA.. /1 133.33... 4 1TV FT¥
INC1_CLK XBA.. /1 13333...
NC2_CLK HBA.. /1 133.33.....
NC3_CLE JBA.. /1 13333....

21  EXTERNAL USE V'
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Hands on ETH: ETH configuration

Open the peripheral configuration: Select Components to find out GMAC 1 Driver and
* Right click on Project, double click

« Select S32 Configuration Tool...

» Select Perlphel’a|S & Components & ¥ Peripherals

I 2 T B
EClodlp  ShowlIn AltsShiftsw > B4 = Frame - (DstAddr + SrcAdd ype filter text @ n
2 *)(txBuffer.data + 13U)) = 6
55 Eth Bxar Show in Local Terminal > ) »
& Inclu
the ETH frame */
& Proje o Copy cul+C length = 64U - 4U; /* D MCAL n
¥ Delete Delete |*-=NE 5 on
@RID o Culey STATUS_SUCCESS = Gmac_Ip_sen
aste -+
& boart _,
@gene T Hename- F2 It = FALSE; Drivers +]
Source >
v (2 gene
se  Move for the frame to be t itt X o G
2 ol & tmport ame o be transmitte “Grmac_1 osif_1 “Siul2_Port_1
Bm % Export. us = Gmac_Ip_GetTransmitStatus
(status == GMAC_STATUS_BUSY);
B O Build Project - - m n
B si Clean Project the frame status */
@gene & Refresh C_STATUS_SUCCESS != status) ||
v g2 src .
& m Close Project 1t = FALSE;
& indlut Close Unrelated Projects Name |ConfigTimeSupport| EthGeneral | EthConfigSet
B desa Build)latgets > lor the frame to be received * Preset Custom... v
% Grna Indlex > Name | EthConfigSet
& Example Build Configurations > us = Gmac_Ip_ReadFrame(INST_GM
(status == GMAC_STATUS_RX_QUEU ~ EthCtriCanfig
Build path > T
Dashboard Build Configurations Explorer ' Cpzn e Name EthCtriConfig 0
- ST 1 Open Clocks EthCtrlEnableMii O
Project Cr( : 5 ' e Reiims EthCtriEnableMmd O
753205 Ar Migrate... & Open DCD EthCtrlEnableRxinterrupt ]
£ 532DS Lit S R SEEms v = Open INT EthCtrlEnableTdnterrupt [
Build/Deb © Run As > Open QuadSPI EthCtrlldx 0
4 Build (Al ¥ Debug As > Open DDR EthCtriMacLayerType ETH_MAC_LAYER_TYPE_XGMII ~
¥ Clean (All Restore from Local History... Import Configuration (*.mex) ~ EthCtriMaclayerSubType
5 Debua ® $32 Configuration Tools > Manage SDK Components REDUCED vIE
Team »
1638M of Compare With N ~ EthCtriMaclayerSpeed

] 5 v ETH_MAC_LAYER SPEED_1G v

~ EthCtrlPhyAddress

66:55:44:33:22:11
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Hands on ETH: Update code

File Edit Mavigate Search Project onfigToaols Peripherals Bun Window  Helg
Generate code method: i v [al | & " Eth Example_DS_001 4 B Update Code ~ : M ‘functional Group
1.Click on any configuration tool, like Pins “Components - g2 Port1 (5 Gmac 1 =

Then click Update Code (ensure desired
project is selected!)

2.The Update Files widow pops up. It shows the Update Files O x [ e
. . . . v & Eth_Example_DS ¢
detail update information. Click ok button. & Binaries
. . . . Generated file Status Al ¥ includes
3.The configuration .c and .h file will be B Pins 5 Project Settings
13 ” - RTD
generated at “generate” folder. ~Bboard) @ R
B Siul2_Port_lp_Cfg.c < no change T generate
ESiulz_Port_Ip_Cfg.h 4 no change # generate/include
-BClocks N Gmac_lp_Cfg.h
Gmac_lp_Sa_BOARD _InitPeripherals_PBcfg.h
“Bboard\ / modules.h
B Clock_|p_Cfg.c # no change % Oslf Cfg.h
ECIDCk_IP_’Cfg.h N Change 5 Siul2_Port_Ip_Defines.h
B Clock_|p_Cfg_Defines.h < no change genertn/re
= SIC
B Clock_|p_PBcfg.c “ no change W Debug_RAM

Options
: @ [ oK Cancel
Always show details before Update ON
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1

{

Hands on ETH: Application code 1

nt main(void)

Gmac_Ip_TxOptionsType txOptions = {TRUE, GMAC_CRC_AND_PAD_INSERTION, GMAC_CHECKSUM_INSERTION_DISABLE};
Gmac_Ip_BufferType txBuffer = {8};

Gmac_Ip_BufferType rxBuffer = {8};

Gmac_Ip_TxInfoType txInfo;

Gmac_Ip_RxInfoType rxInfo;

Gmac_Ip_StatusType status;

uint8 macAddr[6U] = {8U};

uint8 i;

uint8 j = eu;

boolean result = TRUE;

OsIf_Init(NULL_PTR);

Clock_Ip_Init(&Mcu_aClockConfigPB[8]);

*

/* Setup the frame with the Mac address and size */
Gmac_Ip_GetMacAddr(INST_GMAC_®, macAddr);

Hequest a buffer of at least 64 bytes
txBuffer.length = 64U;
if ((GMAC_STATUS_SUCCESS != Gmac_Ip_GetTxBuff(INST_GMAC_@, @U, &txBuffer, NULL_PTR)) || (txBuffer.length < 64U))
result = FALSE;
¥
for (1 = 8U; 1 < 12U; i++)
{
*((uint8 *)(&txBuffer.data[eu] + i)) = macAddr[e + j];
if (j < suU)
It
}
else
{
j = 8eu;
¥
}

24  EXTERNAL USE

Siulz_Port_Ip_Init(NUM_OF CONFIGURED PINS@, g pin mux_InitConfigArre); In?t?al?ze pins to provide the extemal clock to Tx, Rx signals yia the function Siul2_Port_Ip_Init
Initialize clock to Tx, Rx signals via the function Clock_Ip_Init

Gmac_Ip_Init{INST_GMAC_®, &Gmac_@_ConfigPB_BOARD_INITPERIPHERALS); Enable controller, initialize Tx and Rx buffer via the function Gmac_Ip_Init

initialize transmit buffer and Borrow transmit area to load
frame via the function Gmac_Ip_GetTxBuff
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Hands on ETH: Application code 2

/* Payload = Frame - (DstAddr + SrcAddr + EtherType/Length + FCS5) *=/
*((uint32 *)(txBuffer.data + 13U)) = 64U - (BU + 6U + 2U + 4U);

/* Send the ETH frame */

txBuffer.length = 64U - 4U; /* Don't count FCS, because it is automatically inserted by the controller in this example */
if (GMAC_STATUS_SUCCESS != Gmac_Ip_SendFrame(INST_GMAC_@, @U, &txBuffer, &txOptions)) Trigger the transmit frame via Gmac_Ip_SendFrame
{ M

result = FALSE;

}

/* Wait for the frame to be transmitted */
do {

status = Gmac_Ip_GetTransmitStatus(INST_GMAC_&, &U, &txBuffer, &txInfo);
} while (status == GMAC_STATUS_BUSY);

/* Check the frame status */
if ((GMAC _STATUS_SUCCESS != status) || (8U != txInfo.errMask))
{

}

result = FALSE;

L0 o gy e e Do I

ﬂu {
status = Gmac_Ip_ReadFrame(INST_GMAC_®, U, &rxBuffer, &rxInfo);
} while (status == GMAC_STATUS_RX_QUEUE_EMPTY);

/* Check the frame status */ Verify frame is transmitted/ received
if ((GMAC_STATUS_SUCCESS = status) || (eU != rxInfo.errMask))

result = FALSE;
]

Gmac_Ip_ProvideRxBuff(INST_GMAC_@, @U, &rxBuffer);

Gmac_Ip_DisableController(INST_GMAC_8);
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Hands on ETH: Build and Debug 1

Build target Project:

26

Right click on Project,

Build Project

The console print build information
Eth _Example DS 001.elfis created

) Project Explorer

& CAN_example_CT

« & Eth_Exampl
¥ 4 Binaries
% Eth_E
' Includes
& Project_t
& RTD
% board

& generate

& generate

& generate
& src
Debug |

MNew

Go Into

Open in New Window
Show In

Show in Local Terminal
Copy

X Delete
Paste

™ Rename...

Source
Mowve

Import...
i Export..

&% Linflexd_Ua Build Project

= Md_IP_Exar
= Ocu_sxamp

&~ "

EXTERNAL USE

Clean Project
Refresh

Problems &l Tasks B Console = I Properties 4 Search Progress
CDT Build Console [Eth_Example_DS_001]

Building target: Eth_Example_DS_eel.elf
Invoking: Standard S32DS C Linker

arm-none-eabi-gcc -o "Eth_Example_DS_001.elf" "@Eth_Example_DS_@@l.args"

Finished building target: Eth_Example_DS_e@l.elf

Invoking: Standard S32DS Print Size

arm-none-eabi-size --format=berkeley Eth_Example_DS_e01l.elf
text data bss dec hex filename

308144 e 12288 320432 4e3b® Eth_Example_DS_ee1l.elf

Finished building: Eth_Example_DS_e@l.siz

21:24:18 Build Finished. @ errors, @ warnings. (took 26s.539ms)

1 Project Explorer =
* &= CAN_example CT ’
~ 15 Eth_Example_D5_001: Debug_RAM
v & Binaries
| % Eth_Example_DS_001.elf - [arm/le] |
Includes

Alt+Shift+W >
>

Ctrl+C
Delete

& Project_Settings
Ctrl+V S
2 2 board
5 & generate
& generate/include
2 generate/src
& src

Debug_RAM
=
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Hands on ETH: Build and Debug 2

Go to debug configuration: Debug configuration set:

- Right click on Project,
- Select the Debug As
- Click Configurations

Click target project ,

Select the target device
Select target S32 Debug Probe

Name: | Eth_Example_DS_001_Debug_RAM_S32Debug

0 L nenanic.. e - ; )
I" = Eth_Example DS 001: Debu(l Source >

" Binaries Move... 2 Main % Debugger , # Startup % Source ™ Common ' SVD Support #OS Awareness 3 T
i Includes 21 Import... eq */ €1 C/C++ Application Hardware
& Project Setti % [€] C/C++ Remote Application
rojectaetings = Ept= : i [Device: $32G274A Rev2  Core: M7.0 Select device and core_ |
ERTD Build Proiect @ Edipse Application
= board ! ch.e [€1 GDB Hardware Debugging Initialization script: | ${S32DS_INITIALIZATION_SCRIPTS_DIR}/s32g2xx/s32g2xx_generic_bareboa
= generate e gl & GDB PEMicro Interface Debugging [ nitial core
@ generate/include 2 Refresh . [€] GDB SEGGER J-Link Debugging Debug Probe C .
2 generate/src et # Launch Group ebug Probe Connecion
@ src Close Unrelated Projects nces */ #» Launch Group (Deprecated) Interface: $32 Debug Probe - USB v
= Debug_RAM Build Targets s [o OXEF, OxFF, oxff, oxff, exi % Launch Group for S32 Debugger USB device: | 00:04:9£:06:20:40 - S32 Debug Probe v Rel
- , Bxff, exff, exff, oxff, oxi % 532 Deb:
#indude Index > OvFE  OvEf  OvEf OvFE  Ovi 532 Debugger

Ef description. txt

8 Gmac_Fxample DS

Build Configurations

Aay (P N Daas coon L

| Eth Example DS 001 Debug RAM $32Debug I

Hostname or IP:

Target Communication Speed

1.n i b3 p p
& Example_S$32G2XX_DS_Fls: [ B"":j P‘“hf | ’ Ds.001] Mcl_IP_Example_CT_Debug_RAM_S32Debug JTAG Speed (KHz): 16000,  Timeout:|30 s
< oh Build Configurations Explorer = H I M 2
% FlexCAN_example_CT: Debut mple_DS_601.elf Uart_HLD_S32G_DS_Exampl e_Debug_RA _S32Debug 0 Delay after reset: 1¢ e
&5 FlexCAN_example_CT1: Debr SDKs C Linker Wdg_Example_HLD_DS_Debug_RAM_S32Debug
5 FreeRTOS_Example_S32G27: Migrate... h_Example_DS_001.elf" "@Eth_E Wdg_Example_IPL_DS_Debug_RAM_S32Debug GDB Server
: Eth_Example_DS_0@1.elf v
N Show in Remote Systems view - pe_to 532 Debugg.er Flafh Programmer [] Launch server
21 Dashboard % > § Print Size New_configuration Server port number® 45001
T VLAB Simulator Debuggin —
- Project Creation I# Debug As I > [ 1 Local C/C++ Application 99ing []Enable log

Restore from Local History... B8 2532DS C/C++ Application

[ 532Ds Application Project | B <23 Confi N
= 532D Library Project q onfiguration Tools >I Debug Configurations... I
I Team
~ Build/Debug
. Compare With > )

% Build (All) Configure sk ® errors, © warnings. (took
# Clean (All) ®
% Debug ) Source >

¥ Validata
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Hands on ETH: Debug and run

28

Click on “Apply”, then click on “Debug”. the perspective will jump to the Debug Perspective, and you can
use the controls to control the program flow.

Debug Probe Connection Refact Mavigate Search Project ontigTools Run  FreeRTOE

Interface: $32 Debug Probe - USB v A = a:wl B " H ER L EA X,
USB device: 00:04:9f:06:20:40 - S32 Debug Probe ~ | |Refi . .
Hostname or IP: % Debug B ¥

Target Communication Speed w Eth_Example_DS_001_Debug_RAM_S32Debug [S32 Debugger]

JTAG Speed (KHz): Tmeout[30 3 v @& Eth_Example_DS_001.elf [1] [cores: 0]

GDDZGSI::?er e ¥ o Thread #1 1 [core: 0] (Suspended : Breakpoint)

[ Launch server - = main() at main.c: 140 0x340003ac

SDG"E’:;EZTO';“F”““” < C/NXP/S32D5.3.4/532D5/tools/gdb-arm/arm32-eabi/bin/arm-none-eabi-gdb-
DB Client = 532 Debugger

Executable: | ${532DS_GDB_ARM32_PY) | select = Semihosting

Frerman .| v

< >

Revert ‘ Apply
[ Debug | close

EXTERNAL USE
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Hands on ETH: Test result

In this project. The eth frame of Transmit & receive in internal loopback mode. The rxBuffer shows the
received frame.

XPression Type Value
¢ = rxBuffer Gmac_lp_BufferType [
= data uint8 * 0x34501700 <GMAC_0_RxRing_0_DataBuffer> “fUD3\'
#: length uint16 64
0 Memory §
Monitors & X % : 0x34501700 <ot e REMETTGS
¢ Dx3450170 Address 8—3 —F 8 C-F

34501708, 66554433 . 22116655 . 443322]1 . 082E6060
34501710 ©PeoPeee eoeeeEee Oeeeeeee ©0PELeRR
34501720 ©P0E0PE0 ©OREREEP ©PEGEERe  ©0PEEEER
34591730 00000000 ©OPEEERR BAEEBR8A . 65EA1S543
34501740 ©POO0O00 0ORGREOD 00OGERRE  HOPEEEEO
3ase175e LN cecceece eeeceece 00000000
34501760 ©PEEEEE0 ©OGEREEE 0EOGEERE  HEEEEEER
34501770 ©P0O0000 ©EREREEE 000EEERe  HEEEEEER
34501780 ©QOO0E00 ©OLERERE 0OEEERe  HEEEEEEV

- L . . .
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03.

Hands on CAN Example

30 EXTERNAL USE
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Hands on CAN — Objective

—How to import the CAN example into S32DS

—How to configure the clock of CAN via S32DS

—How to configure the port of CAN via S32DS

—How to modify the CAN loopback

—How to debug the CAN example with S32 debug probe

31 EXTERNAL USE
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Hands on CAN : Import CAN example project

Open S32DS3.4, go to “File -> New -> S32DS Project From Example”. Select “CAN_example CT”

example, then click on “Finish”. The project is copied into current workspace.

New
Open File...
. Open Projects from File System...

Recent Files

Close Ctrl+W

Close All Ctrl+Shift+W
™ Rename... Fe
1 Refresh F5

Convert Line Delimiters To

workspaces32D5.3.4 - Linflexd_Uart_lp_532G_D5/description.txt - 532 Design Studio for 532 Plat
File Edit Source Refactor Navigate Search Project ConfigTools Run Window Help
Alt+Shift+N > =

532DS Project from Example
532DS Library Project

- 532DS Application Project

i Makefile Project with Existing Code

C/C++ Project
Project...

=/ Convert to a C/C++ Project (Adds C

Source Folder
Folder

Source File
Header File

File from Template
Class

Example...

i Other...

—)

532D Project from Example.

Create S32DS Project from Example

Praject name:  CAN_example CT
Examples:
¥ 532 RTD AUTOSAR 4.4 D2012 Can Exam| A
[EcWoampecr]
& FlexCAN_example_CT
v 532 RTD AUTOSAR 4.4 D2012 Crc Examg
& Cre_Example_DS
¥ 532 RTD AUTOSAR 4.4 D2012 Crypto Ex:
= Crypto_Aes_Enc_Dec
& Crypto_Cmac_Gen_Ver
& Crypto_Hash

Description:

1. Example Description ~
This is an FlexCAN HLD driver component

LoopBack example.

1.1 The aplication software functionality
Using Clock_lp_lnit it initializes the clock
sources, the clock tree and to configures the clc
gating of the peripherals. The dock configuratic
that is used will enable and use the PLL as soun
clock.

~

o

Cancel

“CAN_example_CT” project is a FlexCAN HLD driver component LoopBack project.

S32G

FLEXCANO

CAN|Frame
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Hands on CAN: the proposed demo need to modify

The “CAN_example CT” project only support loopback model. modify this default project configuration to
build transmit/receive CAN frame from FlexCAN_0 to FlexCAN_1

Automotive Bus Port

%

Bil FIlEFSEY & B0 2 1 ra S| E¥EEY 4 =Ll o3
FI5 FLEX_CAND_H €5 cmmmy E z < FLEX_CAND L P26
IP:E =-EI'—:-‘.M'-|< "}\ £l 7 S :f‘l% SLEK CAN1TL PI5
g r r -1
227 LLCECANIH 003 Ty 5% weeanit
RI7 LLCE CANZH §<§< }i n E H p) ;3 LCE CANZ L P27
T ] ~ AN PI7
o SER o $ LEm
P8 LLCE CANSH 4¢ 5 4T &% LLCECANSL ©2
PIT LLCE CANG H 46% E iy gy I S5 LLCE CAMEL P27
BIT LLCE CANT H <C3 Z1 5 o= &5 LETCaNTL B
P38 LLCE.CANEH <€ 2T 5= W LA b
n2e LLCECANTH <¢ % | O 35 Y% LicEcANSL P
P28 LLCE CANIDH 4455 28 1 27 2% LLCECANTDL I8
P2E LLCECAMTITH 4450 ETH 29 JA% LLCETCAM11L P38
Pan LLCE CANIT H 4605 A, = SN LeEcantzl  pon
an L 3 B CETC AN a0
el i
PI LLCE CANIEH {¢5 ENE &% LLCECaNisL P
e o 5 LREDANTEL RS

L — 1

= onzZe2l =

GHD GHD

AN
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Hands on CAN: Port Configuration 1

- Go to desired configuration tool:

Right click on Project,

- Select Open Pins

&

™

e

Select S32 Configuration Tool...

Routed Pins for BOARD... | 4 |© @ v

# Peripheral Signal
B cavo nd
E7 CAN_O txd
E8 CAN_1 rxd
Co CAN_1 txd

34
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Route to Label

PB_02
PB_01
PB_04
PB_03

Identifier Power group

n/a
n/a
n/a
n/a

VDD_IO_B (0V)
VDD_IO_B (0V)
VDD_IO_B (0V)
VDD_IO_B (0V)

- Modif\{ the Pins as the schematic of CANO and CAN 1

eno |

[ 814 .
7o0gr o5

RS0
o4

PESDRINILT

c3sz | [oopF
il

Direction Qutput Buffer

Input
Output
Input
Output

Disabled
Enabled
Disabled
Enabled

File Edit Sourc

it

> Q@ ®

T Project Explore

~

<

1= CAN_exam
il Includes
= Project_
& src
2% include
B CAN_ex
2 descript
i Clock_Ip_E:
& Example_S.
& FlexCAN_e:
% FreeRTOS |
 led_ M7_0
&= Linflexd_Ue

© Mc|_HLDE .

= Mcl_IP_Fxa
= Mcu_Fxam
= QOcotp_AU’
5 Pit_exampl
= Power_Ip_E
= RDB2_LED_

£ Dashboard =

[

Project Creal

* 532DS Appl

= S32DS Libra
* Build/Debug ©
& Build (All
# Clean (All)
% Debug

¢y FLEK CANIL PR

*

New

Go Into

Open in New Window
Show In

Show in Local Terminal

Copy
Delete
Paste
Rename...
Source

Move...

1 Import...

Export...

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Projects

Build Targets
Index

Build Configurations

Build path

Build Configurations Explorer
SDKs

Migrate...

Show in Remote Systems view
Run As

Debug As

Restore from Local Hist:
S32 Configuration

Toam

Open Drain Input Buffer
Enabled
Disabled
Enabled
Disabled

Disabled
Disabled
Disabled
Disabled

PUBLIC

Alt+Shift+W

Ctrl+C
Delete
Ctrl+Vv

F2

~

>

>

n Window Help
v O v @ vi®my v =Rt

/* Initializes an UART driver*
Uart_Init(&Uart_Config_Vs_e);
/* Uart_AsyncSend transmit dat
(void)Uart_AsyncSend(UART_CHAN
/* Wait for Uart successfully
while(Uart_GetStatus(UART_CHAN

/* Infinite loop:

* - Receive data from user
* - Echo the received data
*/

while (1)

{

/* Receive and store data
* or the buffer becomes fu
*/

(void)Uart_AsyncReceive(UA
/* Wait for transfer to be
while(Uart_GetStatus (UART_

/* Check the status */
Uart_Status = Uart_GetStat

if (Uart_Status != UART_NO

{

pen Pins

/% _T£ am arnmran sAcciinks

Open Clocks
Open Peripherals
% Open DCD

£ Open IVT

= Open QuadSPI
& Open DDR

Import Configuration (*.mex)

Manage SDK Components
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Hands on CAN: Port Configuration 2

- Add the Port configuration: Click the plus button

Click the Siul2_Port component

- Right click an Project The Siul2_Port_1 will be added s compener -
_ Select 832 Configuration TOOI - - [[]Show only components in toolchain project [] Show only latest component versions
Configuration component Component description Category Require ~
SeleCt O en Peri herals RAM RAM Configuration Drivers  platfor
p p *Rtc RTC IPL Configuration Drivers  platfor
+Sd_Emmc_Ip SD Configuration Drivers  platfor
*SEMA42 Semaphores?2 Ip Driver Drivers  platfor
+Sjul2_Dio Drivers  platfor
m ste Culsv THER =Siul2 lcu SIUL2 Driver Drivers  platfor
Clock | = Rename... F2 faalgx:;d::oi ,exo' aSiul2_Port Drivers pIatfonJ
S QEth_E;: Source > Bxe, 0;0, oxe, =Spi_lp Spi Ip Configuration Drivers  platfor
» & Exampl Move. '919"'_”"‘ = =Stm STM IPL Configuration Drivers  platfor
» BHaCA & import.. ’-‘ ;flash_:lk_freq . =Swt_Ip Swt Configuration Drivers  platfor
> B HaCA & Bport.. x@, System_Ip IP configuration Drivers  platfor ¥
» 5 FreeRT¢ 4 ¥ reserved_l */ < >
Build Pr
» 6 led M7 et xFF, \
¥ Clean Project * reserved_2 */
> @ Linflexc
B Rtk XF¥, [ oK | cancel
» & Md_HL * reserved 3 */
> smdp,  SoseProject x££,
S Meu s  Close Unrelated Projects * command_sequences */
. €, oxff, exff, oxff, oxff
» & Ocotp.  Build Targets 3PN e . : 4 2 —— = 7
xf€, Oxff, Oxff, exff, Oxff nents & ¢ nherals
? SPited index > puse’ avee aves’ avee aves ® Components & ¥ Peripherals
» & Power_ Build ations > i
> @ RDB2.I - : T type filter text ot
- & lacks ©Console Propasit s
> & SpiIP_ i ’ orsole [CAN_example_CT1) ' '
. Uart Build Configurations Explorer - e
b 4 target: CAN_example CT1.elf
SOKs Standard 53205 C Linker
Migrate... -eabi-gece -0 "CAN_example CTIi.
< Show in R S v building target: CAN_example_ _
&Dashboarc © Run As * & Standard 53205 Print Size
he

| Build (A
& Cean (A e

® Debug Source

e

s e
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Hands on CAN: Clock Configuration 1

Go to desired configuration tool: Fle Edit Source

OB El ® v

New

Go Into

Laas in New Window

- Right click on Project, & Proiect Bolose

v 1= CAN_examp

Show In

- Select S32 Configuration Tool...

2 Project_S
& src
- Select Open Clocks W incude
# CAN exa
2 descriptic
v &% Clock_Ip_Exe
# Binaries
& Includes
= Project_S
&2 board
2 generate,
2 generate,
& include
52 src
= Debug_R
2 generate
2 RTD
B Clock Ip._
<

# Dashboard #

~ Project Creati
[ S32DS Applic
= S32DS Library
~ Build/Debug
&) Build (All

# Clean (All)

## Debug

36 EXTERNAL USE

Show in Local Terminal

Copy
Delete

Paste

[ i

A

Rename...
Source

Move...

Import...

B E

Export...

Build Project

Clean Project

Refresh

Close Project

Close Unrelated Projects

Build Targets
Index

Build Configurations

Build path

Build Configurations Explorer
SDKs

Migrate...

Show in Remote Systems view

O RunAs
*# Debug As

—Restore from | ocal History..

# 532 Configuration Tools

Alt+Shift+W

Ctrl+C
Delete
Ctrl+V

F2

b

>

Window Help
O~Q~i®qg v ‘Biw |

* Initializes an UART driver*/
art_Init(&Uart_Config_VsS_8);

* Uart_AsyncSend transmit data
void)Uart_AsyncSend(UART_CHANNE
* Wait for Uart successfully se
hile(Uart_GetStatus(UART_CHANNE

* Infinite loop:
- Receive data from user
- Echo the received data b

/

hile (1)
/* Receive and store data by
* or the buffer becomes full
*/
(void)Uart_AsyncReceive (UART
/* Wait for transfer to be ¢
while(Uart_GetStatus(UART_CH
/* Check the status */
Uart_Status = Uart_GetStatus
if (Uart_Status != UART_NO_E
{

[¥ T£ an _arrnr arcueead,
® Open Pins -
Nl Open Clocks
] Opon Darilnhnr;ﬂ
@ QOpen DCD
= Open IVT
= Open QuadSPI
¢ Open DDR

Import Configuration (*.mex)
Manage SDK Components
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Hands on CAN: Clock Configuration 2

Open the Peripheral Clock View, double click the FLEXCANO CLK. The Clocks Diagram will show the power tree and

the key node can be re-set. The default clock configuration of CAN is 40 MHZ. the CAN PE clock source comes from
FXOSC

‘:S{OSC CLE 40 MHz
— = oRid
AOv.. OPe.. @ [@Co.. @Re.. EDe.. Gl - i
32 kHz CORE_FLL ljFI:f ®B00 = l 1 T %g%g
Clock N Enable S Divid F ~ s Aok
(o]0l ame nable ource wiaer req 48 . ZTDCFL;Z - gg'&!%:
DMAMUX2_CLK XBA.. /1 133. e = iy
£ AU B Te] [TTEnAcy E0E Wil 71 i
DMAMUX3_CLK XBA.. /1 133. ﬂ%%ﬁ: o 1 -| e
CEAC T [pTemanl at Wi FIRC o
DMA_CRCO_CLK XBA.. /1 400 Eﬂm:%%g: DOR_PLL PHI i %O'e'é“ iz
DMA_CRC1_CLK XBA.. /1 400 i Poast o 1 FIRC S Bt o
- L] e :}ﬂ—”l . i
EIMO_CLK A53.. /1 481 e pLL 7t Bt o 1
FERTFH_PLL FHI f1 FERIAE Eg B nactive
EIM1_CLK XBA.. /1 66.6 ;‘1 }/ o~ FRCE R DL
it i1 Br 90 e
EIM2_CLK XBA.. /1 66.6 - o/ o [om g i
| CDR 25 Wz
EIM3_CLK XBA.. /1 66.6 . / f“‘“ e Ff‘“ - iRcﬂ 71 Or ;EE ﬁ
EIM_CLK XBA.. /1 66.6
ERMO CLK XBA.. /1 666
FLEXCANO_CLK FXO.. /1 __40 I\
FLEXCAN1 CLK FXO.. /1 40 N
FLEXCAN2_CLK FXO.. /1 40 N g FLEYXCAN CLE
FLEXCAN3_CLK FXO.. /1 40 N 40 WMHz
FRAYO_CLK FIRC.. /1 48 PERIPHFLL PHLZ FLE CMIEO_C}.IEEII{
FTIMERO CLK FIRC... /1 48 N - EXranl CLKZ
FTIMER1_CLK FIRC.. /1 48 N FHOSC_CLE 40_ M=
GMACO_RX_CLK FIRC.. /1 48N v FIRC CLE CANZ_CLE
< > 40 MHz
|— EXCANG CLE
40 MHz
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Hands on CAN: CAN Configuration 1

Open the Clocks Diagram:

- Right click on Project,

- Select S32 Configuration Tool...

- Select Peripherals
Cuv

& Clock | ! Rename... e
5 Eth_Exe Source
& Exampl Move...

& FlexCAl & Import...
= FlexCAl 4 Export...

B FreeRT{ Build Project

& led_M7 .

2 Linflexc Clean Project

5 Ml HL Refresh

2 MclIP. Close Project

5 My B Close Unrelated Projects

= Ocotp_ Build Targets

=5 Pit_exa Index

5 Power_ Build Configurations

= RDB2 |

 SpiIp Build path

& Uart F Build Configurations Explorer
SDKs
Migrate...

<
Show in Remote Systems view

% Dashboarc @ Run As
4 Debug As

~ Project C

(* 53205 A Restore from Local History...

= <3205 L'I # S32 Configuration Tools I
Team

* Build/De i
Compare With

% Build (A Confi

# Clean (A ERIENE

% Debug Source
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X0, Ox0, Oxe, exe,

* dl1_modes */

X0, x0, ©0xe,

* ipcr_mode */

X0,

* sflash_clk_freq */
X0,

* reserved_1 */

xff,

* reserved_2 */

xff,

* reserved_3 */

xff,

* command_sequences */
xff, exff, exff, exff, exff,

xff, exff, exff, exff, exff,
vFf  OvFF OvFf OvFF  ovFf

>

B Console =
onsole [CAN_example_CT1]

target: CAN_example_CT1l.elf
: Standard S$32DS C Linker
eabi-gcc -o "CAN_example_CT1.

: Standard S$32DS Print Size

eabi-size --format=berkeley C
data bss dec he

> ® Open Pins

Open Clocks

Open Peripherals I

Open DCD

Open IVT

= Open QuadSPI

==

m %

3

building target: CAN_example_

& Components © | ¥ Peripherals
| o [n
MCAL L+
T i X
“Can 431 “Canif 43 1 “Dem_1 EcuC 1
K X,
EcuM_1 “Meu_1 051 “Platform_1
X .
osif_1 Siul2_Port_1
Name |CanController| CanHardwareObject

+|[x

0 Name |CanContrcI|er_O
Can Hardware Channel FLEXCAN_O v
Can Controller Activation

0

Can Controller ID |O
Can Rx Processing Type POLLING v
Can Tx Processing Type POLLING v
Can BusOff Processing Type INTERRUPT v
Can Wakeup Processing Type INTERRUPT v
Can Loop Back Mode ] disable Loop Back Mode
Can Auto BusOff Recovery L]
Can Three Samples [
Can Protocol Exception |
Can Edge Filter [
Can FD 1SO [
Can Controller Default Baudrate
Can Controller Ecuc Partition Ref  |/EcuC_1/EcuC/EcucPartitionCollection_0/EcucPartition_4 v
CanCpuClockRef /Meu_1/Mcu/McuModuleConfiguration/McuClockSettingConfig_0/McuClockReferencePoint_ v
CanCpuClockRefAlternate /Mcu_1/Mcu/MauModuleConfiguration/McuClockSettingConfig_0/McuClockReferencePoint_ v




Hands on CAN: CAN Configuration 2

Configure the Baud rate as 500Kbps for Controller O
- TimeQuantum (seconds) = Prescaler / CanClockFrequency
- No. of CanTimeQuantas = (1 / CancontrollerBaudRate) / TimeQuantum
- No. of CanTimeQuantas = 1 + CanControllerPropSeg + CanControllerSegl + CanControllerSeg2

~ CanControllerBaudrateConfig X

R

CanControllerBaudrateConfig_0

CanBaudrateTypeSuport NORMAL_CBT
Can Automatic Time Segments Calculation O
Can Bus Length (meters) 1
Can Propagation Delay Tranceiver (ns) 150
Can Tx ArbitrationStart Delay 0
I Can Controller Prescaller 4 I
Can Controller Prescaller Alternate 4|

iall 0
Can Controller BaudRate (Kbps) 500 I

Can Propagation Segrment

Can Phase Segment 1

Can Phase Segment 2

= o =]~

Can Resynch Jump Width
~ CanControllerFdBaudrateConfig

Add itemn by clicking on plus button
+
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Hands on CAN: CAN Configuration 3

AUTOSAR CAN Driver pcay

Open the peripheral configuration view ome

add a new CanController for FLEXCAN 1 D

Set Hardware Channel as FLEXCAN 1 Name Conf Time Support Can Gentrl CanConfigSt Commonfublshedimlomaione
Set CAN Rx/TX Processing Type as POLLING B CurCorooll EEREIRSENIRPRL

Set CanCpuClockRef as 40Mhz
Marme . .
Can Hardwase Channel ILEK:‘-‘-‘«NJ

Set Baudrate as 500kbps
Can Controler Activation | ] I

~ CanControllerBaudrateConfig . X
Co— " G Cortote 0 ‘
CanontrollerBaudrateC onfa

MName CanControllerBaudrateConfig_0 \ Can Rx Processing Type POLLING
CanBaudrate TypeSuport NORMAL_CBT \

— Can | P I POALLING
Can Automatic Time Segments Calculation | N\ e . .
Can Bus Length (meters) 1 N Can BusOHf Processing Type INTERRLIFT
Can Propagation Delay Tranceiver (ns) 150 \ \
Can Tx ArbitrationStart Delay 0 \ Can Wakeup Processing Type INTERRLIPT

ICan Controller Prescaller 4 I \
Can Controller Prescaller Alternate 4 Set Baudrate ™S Can Loop Back Mode
¢ BaudRate Config 10 0 \ N Can Auto BusOff Recowvery
Can Controller BaudRate (Kbps) 500 I N\ Can Thiee Samples
\ Can Protocol Exception
Can Propagation Segment T \ Can Edge Filter
Can Phase Segment 1 7 N|| CanFD SO
Can Phase Segment 2 5 \Can Controlier Default Baudrate
Can Resynich Jump Width 1 Can Controler Ecuc Partition Ref Eoul 1/ EculEoucPartibionCollection O/ cucPartition 4
_— — E—
» CanControllerf dBawdrateConfig - . . E .5
CanCpuClockRef [Wcu_1/MoyMauMoaduleConfiguration/MauClackSettingConfig_0/MarClockRaferencePaint 0
Add item by dicking on plus button
CanCpuClockRefAltemate ou_T/Wou Mouhodulel cnhourationy Moul locSettngLonbg_UiioullockHeterentePoint D

+
<
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Hands on CAN: CAN Configuration 3

Modify the CanHardwareObjects Configuration for CanController 0 and CanController 1
Set the CanHardwareObjects 0 reference to CanController 1
Set the CanHardwareObjects_1 reference to CanController 0

Name CanController| CanHardwareObject Name | CanController| CanHardwareGbject

+ || x v + || X[~
g Name | CanHardwareObject_0 ‘ 0 Name ‘ CanHardwareObject_1 |
1 FD padding value |O ‘ FD padding value ‘0 |
Can Implementation Type BASIC v Can Implementation Type BASIC v
Can ID Message Type STANDARD v Can ID Message Type STANDARD v
Can Object ID 2 | Can Object ID K |
| Can Object Type RECEIVE | v |Can Object Type TRANSMIT | v
Hardware Object Uses Polling. Hardware Object Uses Polling.
CanTriggerTransmitEnable L] ﬂm&mﬁmﬂe L
I Can Controller Reference /Can_43_1/Can/CanConfigSet/CanController_1 v I Can Controller Reference [Can 43 1/’Cﬂmnﬁﬁew
Can MainFunction RW Period Reference  |/Can 43 1/Can/CanGeneral/CanMainFunctionRWPerio v Can MainFunction RW Period Reference  /Can_43_1/Can/CanGeneral/CanMainFunctionRWPerio v
Can HwObject Uses Block CAN_RAM _BLOCK 0 v Can HwObject Uses Block CAN_RAM_BLOCK_O v
Can Hw Object Count | 1 ‘ Can Hw Object Count 1 |
~ CanHwfilterArray +|[x ~ CanHwfilterArray +| %
0 Name |Can_anFiIter_Object_O | Add item by clicking on plus button
Can Hw Filter Code |O | ~ CanTTHardwareObjectTriggerArray + | (%
S ) i |O | - = Add item by clicking on plus button
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Hands on ETH: Update code

Generate code method:
1.Click on any configuration tool, like Pins

Then click Update Code (ensure desired
project is selected!)

2.The Update Files widow pops up. It shows the
detail update information. Click ok button.

3.The configuration .c and .h file will be
generated at “generate” folder.

42 EXTERNAL USE

E orkspaces3205.3.4 - CAN_example_CT_MM/=src/main.c - 532 C

@ rl B Update Code ~ .IFunv:‘tianaI Group

o We | a0 |[CAN_example CT cc

& Components

Update Files

Generated file | Status
- EPins .
- Bboard\ Enable Pins.
B Siul2_Port_Ip_Cfg.c B create
B Siul2_Port_lp_Cfgh B create
“Ellocks 2 error
=B board\,
M Clock_lp_Cfg.c B create
BClock_|p Cfgh Bl create
B Clock_|p_Cfg_Defines.h B create
B Clock_lp_PBcfg.c B create

R

WIr

Options
Always show details before Update Cl [

OK

[T CER

Cancel

PUBLIC

T oul2_Port_1

42

v &5 CAN_example_CT1

®

2 Includes

& Project_Settings
8 RTD

% board

T generate
£ generate/IntCtrl_Ip

4 IntCtrl_Ip_Cfg.c
5 IntCtrl_Ip_Cfg.h
% IntCtrl_Ip_CfgDefines.h

@ generate/System_|Ip
9 generate/include

& generate/src

9 src

Debug_RAM




Hands on CAN: Application code

26- I.'rt:====================================================
21| * INCLUDE FILES
22 * 1) system and project includes
23| * 2) needed interfaces from external units
24 * 3) internal and external interfaces from this unit )
25| === e === /. can_createdeInfo(ld; s""'deHandle;length, Sdu) '/
26 #include "Meu.h" Can_Pt_iui[nfo = Can_CreatePduInfo(OU, eU, 8U, Can_au8Sdu8bytes);
27 #include "Platform.h" /* Initilize Can driver */
28 #include "Can.h" Can_Init(&Can_Config_VS_0©);
25 #include "SchM_Can.h" Can_SetControllerMode(CanController ©, CAN CS STARTED);
38 #include "check_example.h" /Can SetControllerMode(CanController 1, CAN CS STARTED)}
31 _ if((Can_Write(CanHardwareObject_1, &Can_Pdulnfo) == E_OK))
[f2_#include "Siul2 Port_Ip.h" | while((!CanIf_bTxFlag) &% (u8TimeOut != @U))
- Add the Can_SetControllerModeg
for CanController_1 Can_MainFunction_Write();
1‘22“‘ main(void) Can_DummyDelay(1@0U);
130 uints uBTimeOut = 100U; u8TimeOut--;
1131 CanIf_bTxFlag = FALSE; }
132 CanIf_bRxFlag = FALSE;
133 /* Initialize the Mcu driver */ ; i
154 ey ToTCCLL P Add the Port configuration UBTimeOut = 100U
1;; /* Initialize the clock tree and apply PLL as s stae'pglclgltl/atlon funCtlon while((lCanIf_bRxFlag) && (u8TimeOut I= OU))
137 Mcu_InitClock(McuClockSettingConfig_@); {
138 . .
139 while ( MCU_PLL_LOCKED != Mcu_GetPllStatus() ) Can_MainFunction_Read();
140 { Can_DummyDelay(100U);
141 /* Busy wait until the System PLL is locked * e 2
142 } u8TimeOut--;
143 }
ool s oo e SR Can_SetControllerMode(CanController 8, CAN CS_STOPPED);
146 /* Initialize Platform driver */ Y Can_SetControllerMode(CanController 1, CAN_CS_STOPPED); |
147 Platform_Init(NULL_PTR); Tan DeInit(); - —_—
1148 static Can_PduType Can_Pdulnfo; - ?
IISB Siul2_Port_Ip_Init(NUM_OF_CONFIGURED_PINS®, g_pin_mux_InitConfigArre); I
151 * Can_CreatePdulnfo(1d, swPduHandle,length, sdu) *
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Hands on CAN: Build and Debug

Build target Project:
- Right click on Project

Build Project

- The console print build information

- CAN_example CT1.elf is created

=
& de
= CAN_example_
% Clock_lp_Exam
* & Eth_Example_C
& Binaries
' Includes
@ Project_Sett
& RTD
& board
& generate
¥ & generate/fin
5 Gmac_lp
& Grnac_lp
& modules
W Oslf Cfg
& Siul2_Po

44 EXTERNAL USE

MNew

Go Into

Open in Mew Window

Show In

Show in Local Terminal

Copy

® Delete

Paste

1 Rename...

Source

Move
Import...
Export...
Build Project
Clean Project
Refresh
Close Project

[ Problems ¥ Tasks © Console * [Z Properties + Search % Progress

CDT Build Console [CAN_example_CT1]

Building target: CAN_example_CT1l.elf

Invoking: Standard S32DS C Linker

arm-none-eabi-gcc -o "CAN_example_CT1.elf" "@CAN_example_CT1l.args"
Finished building target: CAN_example_CT1.elf

Invoking: Standard S32DS Print Size
arm-none-eabi-size --format=berkeley CAN_example_CT1l.elf
text data bss dec hex filename

323004 e 12288 335292 51dbc CAN_example_CT1.elf
Finished building: CAN_example_CT1.siz

11:09:19 Build Finished. © errors, 60 warnings. (took 35s.698ms)

v &5 CAN_example_CT1: Debug RAM
& Binaries

Alt+Shift+W > [ % CAN example CT1.elf - [arm/lel]

> Includes

Ctrl+C 9 Project_Settings
Delete 2 RTD

Ctrl+V @ board
F2

>

2 generate

& generate/IntCtrl_Ip
& generate/System_Ip
@ generate/include

& generate/src

&8 src

& Debug_RAM

F5 25 11 1o

“

.
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Hands on CAN: Build and Debug

Go to debug configuration: Debug configuration set:
- Right click on Project,
- Select the Debug As

- Click Configurations

- Click target project ,
- Select the target board
- Select target debugger

&5 Power_lp_Exampl:

Close Project

Select the de:

v = 532 Debugger
| CAN_example_CT_Debug_RAM_S32Debug I
Eth_Example_DS_001_Debug_RAM_S$32Debug

e LW .
- CAN 18 Aft
I = | example C — ], Alt+Shift+W > 2 oy er opel :
® Clock Ip_Bample i j 20 ° prove CEd k. = Name: | Uart HLD_S326_DS_Example_Debug_RAM_S32Debu
&5 Eth_Example_DS. Show in Local Terminal » 20 . || Name: _HLD_$326G_DS _ ple_Debug_ i ebug
=i LS 2 i i1di type filter text — .
& Example_532G2X  Copy Ctrl+C ;}. > G:nir;:;:ﬁtg:;l:;: ype T I Main % Debugger . * Startup % Source| © Common ' SVD Support & OS Awareness
&5 FlexCAN_example X Delete Delete 23 Before runnin _‘EjEH '::’plliat:n eat Hardware
&S T Paste Ctrl+ 24 3.2 Compiling the ke ++ Remote Application
&5 FlexCAN_example P 4 — - .
- FreeRTO; Exanfpl ® Rename.. F2 75 Select the coi @ Edlipse Application IDGVICE. 53262?4A_.Rw2 Core: M7_0 I Select device and core
& led M7 0_ Jebug Source > E? ﬂ:itngiezﬁe'\ 1 GDB Hardware Debugging Initialization script: | ${S32DS_INITIALIZATION_SCRIPTS_DIR}/s32g2x/s32g2x0_generic_barel
@ Linflexd_Uart Ip_§ ~ Move 28 should be cre & GDEB PEMicro Interface Debugging Initial core
& Md_HLD Exampl s Import... 29 2 Running the a [ GDB SEGGER J-Link Debugging )
& Md_IP_Example_( =4 Export... 3@ Go to Run and & Launch Group Debug Probe Connection
&5 Mcu_Example_CT Build Project _:El‘ e # Launch Group (Deprecated) Interface: .532 Debug Probe - USB
= Ocotp_AUTOSAR, Clean Project - - % Launch Group for 532 Debugger USB device: 00:04:9f:06:20:40 - 532 Debug Probe
&5 Pit_example_DS: [ ) N (example) De
- e Refresh F5 = R Hostname or IP:

=5 RDB2_LED_1_MT7_ o Target Communication Speed
& Spi 1P | Close Unrelated Projects * Use the contri ¢ - ]
= Spi_IP_example_C = FlaxCAN_example_CT_Debug_RAM_S32Debug JTAG Speed (KHz): |16000| Timeout:|30 s
5 Uart_HLD_S32G_[ Build Targets » Mcl_IP_Example_CT_Debug_RAM_S32Debug O Delay after reset: 0 =3 i
Index ? Uart_HLD_S32G_DS_Example_Debug_RAM_532Debug 7
Build Configurations > = Wdg_Example_ HLD_DS_Debug_RAM_532Debug GDB Server
o— Build path . Wdg_Example_IPL_DS_Debug RAM_532Debug Launch server
. B Build Configurations Explorer 532 Debugger Flash Programmer Server port number:®| 4500
-~ Project Creation = New confi ti : .
- - SDKs - guration []enable log
- 53205 Application Miarat VLAB Simulator Debugging
= 53205 Library Proj Igrate... MR Cliant
* Build/Debug Show in Remote Systemns view <
& Build (Al 2 Rupis > @ Console
¢ Cloan (a1 | % DebugAs | > © 1Local C/C++ Application ;
15 |-‘+‘|‘-lhj. Restare from Local History... B 253205 C/C++ Application
- Settings - ?32 Configuration Tools ) ] I Debug Configurations... I
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Hands on CAN: Debug and run

46

Click on “Apply”, then click on “Debug”. the perspective will jump to the Debug Perspective, and you can
use the controls to control the program flow.

Debug Probe Connection
Interface: 532 Debug Probe - USB v File Edit Source Refact I 1ate Search  Proiect anfiaTanle Fun  FreeRTOS

USB device: 00:04:9f:06:20:40 - S32 Debug Probe v | |Refi -
= n 2 Y g | o ".Tt;"’ﬁ"l""

Hostname or IP:
= 1=

Target Communication Speed # Debug !

e o teels L v = Eth_Example_DS_001_Debug_RAM_S32Debug [532 Debugger

OB Server v i Eth_Example_DS_001.elf [1] [cores: 0]

[ Launch server ¥ o Thread #1 1 [core: 0] (Suspended : Breakpoint)

s ;‘;Tolumbe"“ l = main() at main.c:140 0x340003ac

DB Clint - C/NXP/S32D5.3.4/53205/tools/gdb-arm/arm32-eabi/bin/arm-none-eabi-gdb-
Executable: |$(S32DS_GDB_ARM32_PY) | select = 532 Debugger

o .| < = Semihosting

Revert ‘ Apply
[ Debug | close
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Hands on CAN: Test result

Through the modification, the CAN frame transmits from CANO to CAN1. the callback function
CanIf RxIndication capture the received CAN frame.

void CanIf_TxConfirmation(PduldType CanTxPduld)
{

CanIf u8TxConfirmCnt++;

CanIf_bTxFlag = TRUE;

void CanIf_RxIndication(const Cap/HwType* Mailbox,
const PduInfoType* PduInfoPtr

1

CanIf_u8RxIndicationCnt++;
CanIf bRxFlag = TRUE;

47 EXTERNAL USE

E
-

v

ion Type Value
PdulnfoPtr const PdulnfoType * 0x3400e84c <Canlf_Pdulnfo.5010>
* SduDataPtr uint8 * 0x3400e7fc <ReceivedDataBuffer.5008+8§...
o *SduDataPtr uint8 1\001"
- SduLength PdulengthType 8

Name :
Details:@x3400e7fc <ReceivedDataBuffer.5008+8>

SduDataPtr

"\0o1\ge2\ee3\ee4\005\086\a\b"

Default:8x3480e7fc <ReceivedDataBuffer.5008+8> "\001\822\003\064\0805\086\a\b"

Decimal: 872474620
Hex:@x3480e7fc

Binary:1161 1110011111111100

Octal: 06400163774

2 Conscle

Monitors

@ (0x3400e7fc Address

3480E7F0

3400E800 |@5068708

34e0E810
34e@E828
34e0E838
34p0@E848
3400@E858
34p@E8c8
34p@E878
3400E8880
3400E8%0

a -3
eéoesese

oeoepese
oecevese
oepepesa
@Foeeese
o8oepege
oeceseee
oepeseee
@Foeeese
eescDhCe2

4 -7
eFeeese2
eeeegoee
oeeegoee
oaeeseee
oapesoea
oaoesoe
Deceea34
4@sCeeee
oaeeseee
oapABeEe
BasA62082

i Ragisters & Problems © Executables @ Debugger Console 0'\lemory

% % K |0x3400e7fc: 0x3400E7FC <Hex> & . % New RendeNggs...

8 -8B C-F
CELEREEEY | 01026304 |
00000000 0PEROBRE
90000000 0PEROBRE
00006EER 0REAOERE
0000000 03000808
00000000 FCE70834
91000000 DRE@SB34
80BBEEEA D5088208
1000600 0REAGERE
@OE5CDID  @@ECDCa2
@06CDCA2  @BECDCA2
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